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Test Case # Baseline_D2D_VB_Plan

Test Case Description
This test case demonstrates the capability of AWIPS to display a representative sample of plan view model products from available models, including the new HiResW model data and HPN data.  

· Prerequisite Conditions: 

-The tester must log on to a graphics workstation (LX) with valid username & password.
The AWIPS system is in an operational state.

- There is no need to test Graphical Aviation products in this test case since there is a new baseline test case that covers that.  The test case that covers this product is called “Baseline_Graphical_Aviation_product”

	Step #
	Action
	Expected Results
	Actual Results


	Pass(P)/

Fail(F)
	Comments

	1. 
	On the upper left D2D drop-down, click, hold, and move the mouse to select 

No Backfill

On the Frames dropdown menu, select 5

	The frame count at the bottom right should display 5.
	
	
	

	2. 
	Using the Volume Browser from the main D2D menu, from Sources > Sfc/Grid select HPE

From Fields > Sfc/2D, open the Precip menu and select Precip Rate then select Load.
Note: If there is no Precipitation occurring in the forecast area, no data will be available to display from the volume browser.
	Surface should appear in the Planes area.

On the Precipitation sub menu, two fields should be in green: Storm Tot Precip and Precip Rate.

The Precip Rate and Storm Total Precip fields are displayed at the bottom of the Volume Browser with the times of the latest inventory records.


	
	
	

	3. 
	Hold down the right mouse button (MB3) over the product legend (in green) and select Load as Image from the menu.

Using MB1, click on the HPE Precip Rate legend (displayed in green).
	The field color-coded image is displayed underneath the contours.  

The field contoured in green will no longer be displayed.


	
	
	

	4. 
	Use the Step Forward button to step through the HPE and HPN grids.

The first grid in the sequence is the HPE grid.  The others are the HPN rain rate grids at 15 min forecast intervals.  
	The base time will stay the same but the forecast time will change according to the number of minutes in the future.  The 0HR label will change to 1HR for the 60-minute forecast.  

NOTE:  The HPN grids will appear to be smoother (less granular) than the base HPE grid.  This is an expected result.


	
	
	

	5. 
	Perform normal D2D navigation actions (zooming, roaming, looping, sampling, etc).
	Should perform as any other grids for a surface parameter.  Note any anomalies.


	
	
	

	6. 
	Wait the amount of the HPE time lag setting (5 min) to verify that data is updating.  
Note:  If there is no Precip occurring in the forecast area, this product will not update until precipitation is present.
	The HPE/HPN Precip Rate grids will update with a new base image and forecast images and new time in the legend.
	
	
	

	7. 
	Using MB3, swap in one of the small windows to the left.  Select Clear, then set the scale to Regional.
	A new window is open at the requested scale.
	
	
	

	8. 
	On the upper left menu drop-down, click, hold, and move the mouse to select 

No Backfill

On the Frames dropdown menu, select 2

	The frame count at the bottom right should display 2.
	
	
	

	9. 
	Repeat Step 2 -3 but replace Precip Rate with Storm Tot Precip.
Note: If there is no Precipitation occurring in the forecast area, no data will be available to display from the volume browser.
	See Steps 2 & 3
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	10. 
	Use the Step Forward button to step through the HPE and HPN grids.

The first grid in the sequence is the HPE Storm Total Precip grid.  The other one is the HPN 1-hour forecasted rainfall accumulation grid.


	The base time will stay the same but the forecast time will change according to the number of minutes in the future.  The 0HR label will change to 1HR for the 60-minute forecast.  

NOTE:  The HPN grid will appear to be smoother (less granular) than the base HPE grid.  This is an expected result.


	
	
	

	11. 
	Perform normal D2D navigation actions (zooming, roaming, looping, sampling, etc).
	Should perform as any other grids for a surface parameter.  Note any irregularities.


	
	
	

	12. 
	Select Clear for all panes
	Clears all panes
	
	
	

	13. 
	From the Scale pull-down menu (left side of toolbar), select N. Hemisphere, North American, CONUS, or Regional depending on what model is to be used.  Usually, CONUS is the default scale and generally most models will be able to be displayed on this scale.
	Main pane map scale changes to selected scale.
	
	
	

	14. 
	From the Frames pull-down menu (right side of toolbar), select the highest number of frames 64.
	Number of frames available becomes 64.
	
	
	

	15. 
	From the Volume menu, select Browser.
	The Volume Browser window opens.
	
	
	

	16. 
	In the Volume Browser select a source from the Volume list.  NOTE: The number of models available on each scale will vary.  Pick any source, but you may want to try and stick to the main models such as GFS, NAM, etc.
	Source shows up highlighted (yellow) in the source selection list.
	
	
	

	17. 
	In the Volume Browser select a field from one of the lists (Basic, Wind, Derived, Sfc/2d, Other, Radar, Ensemble).  Select a green colored field in the menu.  NOTE: Many of the submenus are colored black, but there may be green fields under them to select.
	Field shows up highlighted (yellow) in the field selection list.
	
	
	

	18. 
	In the Volume Browser select a plane from one of the lists (Pres, Theta, Hgt, Misc, Lyrs).  Select a green colored plane in the menu.  NOTE: Many of the submenus are colored black, but there may be green plane under them to select.
	Plane shows up highlighted (yellow) in the plane selection list; product shows up highlighted (yellow) in the product selection list.
	
	
	

	19. 
	To remove selected items from the volume browser, use the clear options under the edit menu.  It is possible to clear all or just a source, field, or plane.  If a source, field, or plane is cleared the products in the product list will also be cleared.
	Selections are removed.
	
	
	

	20. 
	From time-to-time toggle between time and space.  The pull-down menu for that is located next to the view pull-down menu.
	The will toggle between loading each frame sequencing in time (model initiation through forecast hours) and space (bottom of troposphere or ground to top of troposphere… generally 1000mb to 150mb).
	
	
	

	21. 
	In the Volume Browser select the Load button at the bottom.
	Product is loaded in the main pane as a graphic.  It defaults to the last frame.
	
	
	

	22. 
	Close the Volume Browser: File > Exit.
	Volume Browser closes.
	
	
	

	23. 
	View all the frames (model forecast times) by using the arrow keys on the keyboard or toolbar and make sure the date displays correctly and with the right time stamp.  The model data should step ever 1-3hrs for RUC, 3hrs for NAM, 6hrs for GFS & NGM.  
	The model data should change from frame to frame.  Generally, most features between 60N and 20N latitude will move west to east most of the time.
	
	
	

	24. 
	Select clear on the D2D toolbar menu.
	Product is cleared from the main pane.
	
	
	

	25. 
	Complete steps 13-24 for 3 more different sources, fields, and planes.  

	Steps 13-24 were executed successfully for 3 different sources, fields, and planes.
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	26. 
	Load a sample of the SREF selections under the Ensemble Field. The selections can be several menu levels deep.

The available SREF planes are listed in Table 1.  
	The selected SREF products load on the North American, CONUS, Regional, State(s) and WFO scales.
	
	
	


Table 1
	Available Planes in the Volume Browser for SREF model

	Field
	SREF Means & Spreads
	SREF Probabilities

	Pres
	1000, 850, 700, 500, 250 MB
	850 MB

	Misc
	Misc: Surface
	Surface, BL, Cloud Ceiling

	Lyrs
	Layer, 1000-850 MB
	


	27. 
	Toggle all layers off and toggle each on one at a time. Verify that the product legend is correct.
	The product legend should list the correct product name, time and date for the displayed image.
	
	
	

	28. 
	On the graphics workstation, display the Gridded MOS products:
Clear D2-D and select the CONUS scale.

From the Volume Browser select GriddedMOS under SfcGrid :

Select MDL MOS under Sfc/2D


Select Max Temp, Min Temp, POP 6h, POP 12 hr, Tstorm Prob 3hr, Tstorm Prob 6hr, Tstorm Prob 12hr, 24hr Snowfall

Press Load to load the grids.
	The selected GriddedMOS products load on the CONUS, Regional, State(s) and WFO scales.
	
	
	

	29. 
	Toggle all layers off and toggle each on one at a time. Verify that the product legend is correct.

	The product legend should list the correct product name, time and date for the displayed image.
	
	
	

	30. 
	Repeat Steps 30-32 for the Regional, State(s) and WFO scales.
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	31. 
	The ECMWF-HiRes display is available for Northern Hemisphere, N. American, CONUS and Regional scales. Load a sample of ECMWF-HiRes parameters. 
Toggle all layers off and toggle each on one at a time. Verify that the product legend is correct.
	The selected ECMWF-HiRes products load on the Northern Hemisphere, N. American, CONUS and Regional scales.
The product legend should list the correct product name, time and date for the displayed image.
	
	
	

	32. 
	Select Clear
	Clears the D2D main pane
	
	
	


	33. 
	The HiResW display data is now available for the N. American, CONUS, Regional, and State(s) scales.  Depending on the testbed being run on.  Load the data in Table 2 below for the corresponding testbed being tested.  Load this data for each scale and toggle all layers off and toggle each back on one at a time. Verify that the product legend is correct. 
	The product legend should list the correct product name, time and date for the displayed image.
	
	
	TBW3: 24 steps
TBDW: 32 steps
TBDR: 16 steps
TBW4: 8 steps



	34. 
	Clear D-2D. From the Scale pull-down menu (left side of toolbar), select WFO. Usually, CONUS is the default scale.
	The main D-2D panel is cleared and the scale is changed to WFO.
	
	
	

	35. 
	Make sure the proper radar ID is set as home.  To set as home, open the Choose by ID GUI (Tools > Choose by ID) and type in the radar ID (kxxx) into the home box at the bottom, and then press the Enter key. The close the GUI.

	Radar ID is set to kxxx.  
	
	
	

	36. 
	Load plan view radar data: 
Open the Volume Browser:

Volume > Browser
	Volume Browser opens.
	
	
	

	37. 
	In the Volume Browser make sure the type is set to Plan View from the top center pull-down.
	The Volume Browser size and options change.
	
	
	

	38. 
	In the Volume Browser, select radar as the source:

Volume->Radar
	Source shows up highlighted (yellow) in the source selection list.
	
	
	

	39. 
	In the Volume Browser, select radar reflectivity as the field:

Radar- >Reflectivity
	Field shows up highlighted (yellow) in the field selection list
	
	
	

	40. 
	Select the following Plane:

Hgt->1500m
	Plane shows up highlighted (yellow) in the plane selection list; product shows up highlighted (yellow) in the product selection list.
	
	
	

	41. 
	At the bottom of the Volume Browser select Load.
	Data is loaded into main pane of D2D as a graphic.  
	
	
	

	42. 
	Close the Volume Browser: 

File > Exit
 
	Volume Browser closes.
	
	
	

	43. 
	Change the graphic to an image by clicking and holding MB3 over the product name in the product list (lower right of main pane).  Use the menu to select: load as image. 
	Graphic remains loaded with image loaded under it.
	
	
	

	44. 
	Sample the image by holding down MB1 while moving the mouse around.
	Magnitude of the data field is displayed next to the cursor.
	
	
	

	45. 
	Select Clear on the D2D toolbar.
	The main pane is cleared.
	
	
	

	46. 
	Complete steps 38-45 two more times by loading radial velocity and column max reflectivity as fields.  
	Steps are completed successfully.  
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	47. 
	Do not clear the main pane yet.  The column max reflectivity should still be loaded and that will be used to set a baseline.  In order to make a cross section you must select an area to sample.  On the D2D toolbar select the baseline button (has an image of three lines).  
	The Interactive Baselines appear (ABCDEFGHIJ).
	
	
	

	48. 
	Observe the baselines and choose the one that is to be used to make the cross section.  To move the baseline, move the mouse over the center of the line, right click, hold, move the mouse, and let go at the desired location.  To move a vertex (point on line, move the mouse over a vertex, right click,  hold, move the mouse, and let go at desired location.  Move the baseline to an area where the column max reflectivity is a large value.  Remember the line ID letter.
	Line and/or vertex moves to desired location.  
	
	
	

	49. 
	From the Volume menu, select Browser.
	The Volume Browser window opens.
	
	
	

	50. 
	In the Volume Browser select Cross-section from the pull-down menu labeled Plan View.
	The Volume Browser size and options change.
	
	
	

	51. 
	In the Volume Browser select radar as a source:

Volume > Radar
	Source shows up highlighted (yellow) in the source selection list.
	
	
	

	52. 
	In the Volume Browser select reflectivity as a field:

Other > Reflectivity
	Field shows up highlighted (yellow) in the field selection list.
	
	
	

	53. 
	In the Volume Browser select the baseline that was just aligned in step 47.

Specified > Line X.
	Plane shows up highlighted (yellow) in the plane selection list; product shows up highlighted (yellow) in the product selection list.
	
	
	

	54. 
	At the bottom of the Volume Browser select load.
	Data is loaded into main pane of D2D.
	
	
	

	55. 
	Change the product set to load from a graphic to an image by clicking over the product with the right mouse button (MB3) and select the second option in the pop-up menu.
	Product set to load changes to an image.
	
	
	

	56. 
	Sample the image by click and holding down MB1 while moving the mouse around.
	Magnitude of the data field is displayed next to the cursor.
	
	
	

	57. 
	Clear D-2D and select the North America scale.
	The main D-2D pane is cleared and North America scale is selected.
	
	
	

	58. 
	In the Volume Browser Select 

SfcGrid(GriddedMOS
	Item selected
	
	
	

	59. 
	Select Basic( Temperature
	Item Selected
	
	
	

	60. 
	Click Load
	The Temperature data will now be loaded in D2D and the contoured field will be displayed 
	
	
	

	61. 
	Repeat Steps 57-60 with Rel. Humidity, Dewpoint, Wind Speed, and Wind Direction.
	See steps 57-60
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	62. 
	Clear D-2D, clear the Volume Browser Fields and Planes, and select Sfc/2D (  MDL MOS( Max Temp
	Item Selected
	
	
	

	63. 
	Click Load.
	See Step 62
	
	
	

	64. 
	Repeat steps 62-63, but select Min Temp, POP 6hr, and POP 12hr.
	See Steps 62 and 63
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	65. 
	Clear D-2D and clear the Volume Browser Sources, Fields and Planes. Set the scale to CONUS then from the kxxx menu, go down to Best Res Z/V and select 0.5 Z/V


	The kxxx 0.5 Refl and kxxx 0.5 Vel products load.
	
	
	

	66. 
	From the Volume menu, go down to Std Env Data Packages and select RUC40
Note that nothing is displayed in regards to the model data.
	When loaded, three product legends appear for the RUC40 model, including

RUC40 0.5deg Wind

RUC40 0.5deg Rel Humidity
RUC40 0.5deg Temperature
However, by default, the Density is set to zero, therefore no graphics are displayed.
	
	
	

	67. 
	Sample the display by pressing MB3 and releasing it in the box labeled Sampling in the pop-up window. 
Note the radar reflectivity readout, and in addition, note the data displayed from the RUC40 model for Wind, Rel Humidity, and Temperature.

	When sampling the product, the following appear in the readout:

Radar Reflectivity (dBZ)
[NO DATA nnnn ft MSL mmm ft AGL  xx nm @yyy kbox]

RUC40 Wind (kts)   [nnn deg  mm kts]
RUC40 Rel Humidity %)   [RH= xx%]
RUC40 Temperature (C)   [T= -yyC]
Note that there is no data being shown for the overlays, they just sample.
	
	
	

	68. 
	Using MB3, pop up the menu on the RUC40 Wind product legend and change the Density to 1.


	Note the display of wind barbs over the reflectivity display.
	
	
	

	69. 
	Set the Density for Rel Humidity to 0.5 and for temperature to Max.
	Model data are overlaid on the reflectivity product.


	
	
	

	70. 
	Verify that the data on the display is auto-updating.


	The time for the radar data in the legend is incremented as new data is received.
	
	
	

	71. 
	From the menu bar, select Clear
	The display clears.
	
	
	

	72. 
	Repeat the previous 6 steps with other Environmental Packages (NAM, GFS, etc.) and other radar data (1.5 Z/V, or 1.0 Z/SRM8, etc.)


	Model data are overlaid on the selected products, and the display auto-updates.


	
	
	

	73. 
	From the kxxx menu, go down to kxxx Best Res Refl and select 0.5 Refl

	The kxxx 0.5 Refl product loads in D-2D.
	
	
	

	74. 
	From the top of the Volume menu, select Popup Skew-T

	The Radar Popup SkewT legend appears in the lower right of the display.
	
	
	

	75. 
	With the cursor over the display, click MB3 to open the popup menu.


	The popup menu includes Sample Cloud Heights/Radar Skew-T.
	
	
	

	76. 
	Select Sample Cloud Heights / Radar Skew-T

	In the resulting menu, there exists a list of models and a Skew-T option.
	
	
	

	77. 
	In the resulting menu, select a model.
Note that Skew-T is pre-selected.
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	The pop-up display of the skew-T for the selected model appears.
	
	
	

	78. 
	Sample the display by moving the cursor around the display.
Note that the skew-T recalculates based on the location of the cursor.
Then close the Skew-T window.
	While sampling, the Skew-T is recalculated based on cursor location. Note the latitude and longitude readout, at the bottom of the Skew-T window depicting the point of the Skew-T.

	
	
	

	79. 
	From the menu bar, select Clear
	The display clears.
	
	
	

	80. 
	From the kxxx menu, go down to kxxx Best Res Refl and select 0.5 Refl
	The kxxx 0.5 Refl product loads into D-2D
	
	
	

	81. 
	From the Volume menu, go down to Std Env Data Packages and select RaobOA

Note that there are additional product legends displayed.
	The RaobOA 0.5deg Wind, Rel Humidity and Temperature load.

Note the product legends are displayed:

RaobOA 0.5deg Wind

RaobOA 0.5deg Rel Humidity
RaobOA 0.5deg Temperature


	
	
	

	82. 
	Note that no Raob data are displayed. Again, use MB3 on the product legend and change the density to something other than 0.


	When the density is set non-zero for a product, that product is displayed.
	
	
	

	83. 
	From the Wind product pop-up menu, select Load as Streamlines.


	The RaobOA 0.5deg Wind Strmlns product loads.
	
	
	

	84. 
	Sample the display by moving the cursor around the display.

Using MB1, turn on and off various products by clicking on the product legends.

	The radar and RaobOA display samples for Temperature, Rel Humidity, and Wind data in addition to the radar data.  Note: when the product is toggled off, it is no longer appears in the sampled data display.


	
	
	

	85. 
	From the menu bar, select Clear
	The display clears.
	
	
	

	86. 
	On the kxxx menu, select kxxx four panel, go down to Best Res Z/V and select 

0.5, 1.5, 2.4, & 3.4

	The four panel radar products display.
	
	
	

	87. 
	From the Volume menu, go down to Std Env Data Package and select NAM12

Observe the product legends in the lower right of each panel.


	Note that the product legend for each radar elevation indicates that the corresponding model data exists.  However, note that no model data are displayed yet.
	
	
	

	88. 
	In one of the four panels, press MB3 over the product legend of one of the three model products (Wind, Rel Humidity, Temperature). For example, select Wind. 


	The pop-up menu opens and the Density defaults to 0.
	
	
	

	89. 
	In the pop-up window, select Density and select 0.5
	A Density setting other than 0 is selected and the NAM12 model Wind data are displayed for the radar elevation in that particular panel.


	
	
	

	90. 
	In a different panel, press MB3 over the product legend of Rel Humidity.  In the pop-up window, select Density and select something other than 0.
	A Density setting other than 0 is selected and the NAM12 model Rel Humidity data are displayed for the radar elevation in that particular panel.


	
	
	

	91. 
	In a different panel, press MB3 over the product legend of Temperature. In the pop-up window, select Density and select something other than 0.
	A Density setting other than 0 is selected and the NAM12 model Temperature data are displayed for the radar elevation in that particular panel.


	
	
	

	92. 
	In the fourth panel, press MB3 over the product legend of all products. In the pop-up window for each, select Density and select something other than 0.
	A Density setting other than 0 is selected and the multiple NAM12 model data are displayed for the radar elevation in that particular panel.


	
	
	

	93. 
	Verify that the data on the display panels are auto-updating.


	The time in the radar legend increments as new data is received.
	
	
	

	94. 
	Sample the display by moving the cursor around in each panel.

Note that Wind, Rel Humidity, and Temperature data are displayed.


	All four panels sample with the model data for the particular radar elevation in the panel.

Note too that the pop-up skew-T can be used.  However, the skew-T responds to the cursor position in the upper left panel, regardless of 

a) in which panel the arrow pointer is located, or 

b) where it is loaded, if not in all panels.

	
	
	

	95. 
	Repeat steps 85-94 with 1 more different radar tilt (see menu) and using 1 other model data (NAM, GFS, etc.).
	All four panels sample with the model data for the particular radar elevation in the panel.
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	96. 
	From the menu bar, select Clear
	The display clears.
	
	
	

	97. 
	From the D2D menu bar, select Volume > Browser . . .


	The Volume Browser launches.
	
	
	

	98. 
	In the Volume Browser, select

Planes > Tilts > 0.5 deg

	The Radar Tilts sub-menu appears, displaying the 0.5 deg tilt for the radar.
	
	
	

	99. 
	In the Volume Browser, select:

Sources > Volume > NAM40

Fields > Basic > Temperature


	Note the selected product in the Product Selection List and the entry in the Times field.
	
	
	

	100. 
	Select the product in the Product Selection List and click on Load

	The NAM 0.5 deg Temperature product loads.
	
	
	

	101. 
	Repeat Steps 98-100 with 1 different grid, field and plane.


	The selected products load for the selected tilts.
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	102. 
	Verify that the data on the display is auto-updating.


	The time in the legend increments as new data is received.
	
	
	

	103. 
	From the menu bar, select Clear
	The display clears.
	
	
	

	104. 
	From the kxxx menu, go down to kxxx Best Res Refl and select 0.5 Refl
	The kxxx 0.5 Refl product loads into D-2D
	
	
	

	105. 
	From the Volume Browser select the following:

Source: Volume->GSF40

Planes: Pres->850 mb

Fields:

Basic->Temperature

Basic->Dew Point

Select Load.
	Products are loaded on

D-2D
	
	
	

	106. 
	Check the product legends for the data loaded from the Volume Browser. If should have 850mb instead of 0.5 mb
	
	
	
	Should be resolved for DR #20441

	107. 
	The following steps need to be run on TBW4 with Hawaii localization.

From Volume Menu >> Volume Browser

Grid (Sources) >> HI-RTMA Basic (fields) >> Temp
	Volume Browser opens and given selections are made.
	
	
	

	108. 
	Click Load
	Field selected is loaded.
	
	
	

	109. 
	Repeat Steps 106 -108 with

Dewpoint.

	Field selected is loaded.
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	110. 
	Repeat Steps 106 -108 with
Dewpoint Analysis Uncertainty.
	Field selected is loaded.
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	111. 
	Repeat Steps 106 -108 with
Wind Speed.
	Field selected is loaded.
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	112. 
	Repeat Steps 106 -108 with
Wind Speed Analysis Uncertainty.

	 Field selected is loaded.
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	113. 
	Repeat Steps 106 -108 with
Wind Direction.


	Field selected is loaded.
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	114. 
	Repeat Steps 106 -108 with
Wind Direction Analysis Uncertainty.

	Field selected is loaded.
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	115. 
	Repeat Steps 106 -108 with
Wind.
	Field selected is loaded.
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	116. 
	From the Scale pull-down menu (left side of toolbar), select CONUS.  
	Main pane map scale changes to selected scale.
	
	
	

	117. 
	From the Volume menu, select Browser.
	Volume Browser window opens.
	
	
	

	118. 
	Select SfcGrid(TPCSurgeProb, 

Select Sfc/2D(Probabilistic Storm Surge ( height w/10% chance of being exceeded
	Probabilistic Storm Surge product is ready to display.
	
	
	

	119. 
	Click the Load button.


	D2D displays the latest Probabilistic Storm Surge image available.
	
	
	

	120. 
	Exam the color bar and the legend.  Color bar should be in the upper left corner.  The legend should be in the lower right corner.
	Legend should read:

“TPCSurgeProb Storm Surge Img(ft) DD.hh ##HR ddd hh:mmZ DD-MMM-YY”  where ddd is day of the week, hh is hour, mm is minute, DD is day of month, MMM is month, and YY is year.  
	
	
	

	121. 
	Repeat steps 118-120 with other Gridded Storm Surge products: Probabilities of > 2-foot surge.

	Color bar labeled as “5,10,20,30,40,50,60,70,80,90” and legend is “TPCSurgeProb Storm Surge img (%) DD.hh ##HR ddd hh:mmZ DD-MMM-YY”
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	122. 
	Hold right click on the display and select option sampling
	Sampling option has selected
	
	
	

	123. 
	Move the cursor around and verify the sampling is displayed in % based on brightness-to-value mapping.
	Image value shown below the cursor: N/A displayed for no data or ###% displayed where there is data.
	
	
	

	124. 
	Mid-click on the display.
	D-2D display zoomed in.
	
	
	

	125. 
	Left-click on the display
	D-2D display zoomed out
	
	
	

	126. 
	Hold mid-click and move the mouse arbitrarily.
	The display move as same direction as the mouse
	
	
	

	127. 
	Select Maps ( Counties
	The display overlaid with counties.
	
	
	

	128. 
	Set the frames to 18 and check that data is available for all times.
	
	
	
	

	129. 
	Right-click on the Product Legend and click Load as Image.
	Product loaded as image.
	
	
	

	130. 
	Repeat steps 117-129 at the WFO scale.
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	131. 
	Repeat for all TPCSurgeProb products.
	
	
	
	

	132. 
	Close the D2D applications:

File > Exit.
	D2D closes.
	
	
	


Table 2:

	
	TBW3
	TBW4
	TBDW
	TBDR

	Source
	HiResW-nmmEast, HiResW-arwEast, HiResW-nmmWest, HiResW-arwWest, HiResW-nmmSJU, & HiResW-arwSJU.
	HiResW-nmmAK & HiResW-arwAK.
	HiResW-nmmEast, HiResW-arwEast, HiResW-nmmWest, HiResW-arwWest, HiResW-nmmSJU, HiResW-arwSJU, HiResW-nmmPR, & HiResW-arwPR ***(Need to localize testbed for HFO to view the PR data)***
	HiResW-nmmEast, HiResW-arwEast, HiResW-nmmWest, & HiResW-arwWest.

	Field
	Select 1 different product from each of the 7 different fields.  (1 from Radar, 1 from basic, ect…)
	Select 1 different product from each of the 7 different fields.  (1 from Radar, 1 from basic, ect…)
	Select 1 different product from each of the 7 different fields.  (1 from Radar, 1 from basic, ect…)
	Select 1 different products from each of the 7 different fields.  (1 from Radar, 1 from basic, ect…)

	Plane
	Select 1 product from each of the 7 different planes.  (1 from hPa, 1 from Misc, ect…)
	Select 1 product from each of the 7 different planes.  (1 from hPa, 1 from Misc, ect…)
	Select 1 product from each of the 7 different planes.  (1 from hPa, 1 from Misc, ect…)
	Select 1 product from each of the 7 different planes.  (1 from hPa, 1 from Misc, ect…)
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